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Features of DS-Win V4
1  DS-Win V4

DS-Win V4 is an electronic phone book designed for attendant consoles and 
office workstations. It consists of DS View for the application as well as GUI 
Designer and DS-Admin for customization and modifications. It has been 
designed on the basis of the latest technical know-how and is extremely user-
friendly. The wide range of features offered by GUI Designer and DS Admin 
enable you to configure your phone directory to suit your special requirements 
and thus optimize it for your work. 

1.1  Features of DS-Win V4 

Application Areas

The DS-Win V4 electronic phone book can be integrated fully in the PC attendant 
console AC-Win IP V2 and BLF-Win V4. Used in conjunction with this product, it 
provides a complete system that leaves nothing to be desired in terms of 
functionality, flexibility and user convenience. No matter whether you are looking 
for the phone number of a subscriber, a particular key word, a specialist field or a 
sphere of responsibility, all you have to do is press a few keys and DS View does 
the rest.
DS-Win V4 can, however, also be used on an office workstation. The integrated 
dialing aid allows a call to be set up automatically from the connected telephone 
after the desired call partner has been found.

DS-Win Characteristics

The DS-Win V4 electronic phone book is a directory service that can be 
customized for use on a PC and in a client/server configuration. The following 
functions are available:

• Telephone information system for attendant console and/or workstation with 
DS View functions

• Configuration of the database and the user interface to one’s own 
requirements with DS-Win Designer

• Administration of all subscriber data including display of notes

• Distributed database, client/server technology

• Synchronization with host databases via LAN 

Please see the Release Notes for the current supported Windows versions.

Individually Configurable Database

The new DS-Win V4 database provides you with tables in which you can record 
data such as employee names, room numbers, departments, e-mail addresses, 
product catalogs, keyword lists and much else. Apart from permanently set tables 
A31003-G6640-U100-5-7619, 06/2020
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in which you can adapt the fields to suit your requirements you also have the 
option of adding new fields and even of creating new tables. This is particularly 
useful if you want to have access to information that has only an indirect bearing 
on the telephone directory, such as hotel or restaurant addresses, notes, 
procedures, and so on.

A corresponding JDBC driver also provides access to other databases such as 
MS SQL Server 2005, MS Access and MYSQL. Existing databases containing 
your personal data, for example, can thus be used. 

Individually Configurable User Interface

You yourself can determine how your data will be displayed on the screen. For 
this purpose, DS-Win V4 includes a design tool (see the DS-Win V4 Designer 
manual) that provides you with all the resources you need to configure the output 
of information on the screen in line with the requirements of your work. 

Finding and Modifying Data 

There are two basic search modes available: speed search and query. 

• For a speed search, enter individual characters in a search field and move 
progressively closer to the subscriber or term you are looking for until the 
"correct" one is finally found. 

• In query mode, enter several search criteria, where necessary, and let the 
system search for all data records that correspond to these criteria.

You can move (navigate) in the dataset, rearrange the search result according to 
different criteria, edit or delete records or add new ones.

Dial Functions

DS-Win supports not only the automatic telephone dialing equipment of the PC 
attendant console AC-Win, but also the optiPoint telephones through the USB 
interface. It can thus be used at both an attendant console as well as an ordinary 
workstation. 

Printing Data

You can select different layouts for printing your data records or search results 
with the option of printing the entire dataset or individual records. DS-Win iReport 
from JasperSoftuses the software which can be used to create test pages.

Import/Export

Large volumes of data can be imported and exported via a flexible interface. The 
DS-Win database can be synchronized with host databases, for example the 
central HDMS/OpenScape 4000 Manager (OS4K) database, either manually or 
automatically according to a predefined timetable.
 A31003-G6640-U100-5-7619, 06/2020
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Configuration Overview
1.2  Configuration Overview

Figure 1 Configuration Overview: DS-Win - OpenScape 4000 Network
A31003-G6640-U100-5-7619, 06/2020
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1.3  Concept of the DS View User Manual

Purpose of this Manual

This manual describes how to operate the system from the perspective of the 
user. The manual should 

• describe the correct procedure for using DS-Win functions,

• indicate the correlation between the individual functions,

• serve as a reference for users familiar with the product.

An index and glossary are included.

Structure of the Manual

The application-based chapters of the DS View User Manual are: 

• Chapter 2: 
Using the Data View Window, which provides access to the available data.

• Chapter 3:
Using an e-mail Client and Presence Management. 
 A31003-G6640-U100-5-7619, 06/2020
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Starting DS-Win
2  Data View

DS-Win is operated via the "Data view" window. This provides the user with an 
interface for entering and displaying phone book data. 

Important
In the following description of operating procedures it is assumed that the system 
is fully installed and ready for operation.

2.1  Starting DS-Win

Step Action

1 Via "DS View" in the Start menu, open the application under Programs DS-Win V4. A connection to the 
license server as well as a valid license are prerequisites for this. 

If the entries are correct, the "Data View" window is opened.
A31003-G6640-U100-5-7619, 06/2020
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2.2  Settings

2.2.1  Application Settings

The first time you start DS-Win, you will need to make the following settings on 
the Dial parameters tab in the Options/Application settings menu in order to 
operate DS View. 
 A31003-G6640-U100-5-7619, 06/2020
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Settings
• Standard dialog form
Select the dialog document for DS View. This form will be invoked the next 
time you start DS View. 

• Default language
Specifies the default language to be used the next time DS View starts.

The following settings under "Dial parameters" are for configuring automatic 
dialing.

• Modem
This setting is only required if you are using DS-Win without AC-Win. Select 
the connection type from the drop-down list. The options are:

– HDAUDIO SoftV92 Data Fax Modem

– RAS PPoE Line 0000

– RAS-VPN-Line 0

– WAN-Miniport (L2TP)

• Country code (required input)
Enter your own country code here.

• Area code (required input)
Enter your area code here.

• Net code (required input)
Enter your net code here. For further information, consult your specialist staff.

• Tie number (required input)
Enter your system’s tie number here. For further information, consult your 
specialist staff.
If your configuration uses tie numbers, it is very important that you enter them, 
since DS View can only process tie numbers if they are entered here.

• Trunk access (required input)
If trunk access is used in your system, enter the code here. For further 
information, consult your specialist staff.

• National access code (required input)
Enter an access code here for calls to the national network, e.g. 0.

• International access code (required input)
Enter an access code here for calls to the international network, e.g. 00.

• Domain list
Enter one or more domains.
A31003-G6640-U100-5-7619, 06/2020
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2.2.2  DS-Win Presence Settings

Select the Presence Management tab under Application settings.

The Domino Server settings are only valid when Lotus Notes is used. If you use 
MS Outlook, these fields are inactive.

Settings

• Use Presence Management
This checkbox is not ticked. If you want to use presence management, tick 
this box. DS-Win has to be restarted for the on/off setting to take effect.

• Presence Management type
This setting depends on whether you use Lotus, Outlook 2003, Webdav, 
Exchange 2007, or Exchange 2010. Only one option can be used.
 A31003-G6640-U100-5-7619, 06/2020
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Settings
• Number of maximum work days
The search for appointments is limited by the value specified for the maximum 
number of work days. 
The following applies for Outlook: Work days are considered to be all days 
except Saturday and Sunday. Holidays are ignored.

• Start work hour
The time when the work day starts. This value specifies the beginning of the 
daily interval in which appointments can be searched for.

• End work hour
The time when the work day ends. This value specifies the end of the daily 
interval in which appointments can be searched for.

• Refresh period (Min)
Update period for Outlook – The default is 3 minutes

• Time zone
You will find further information in the Outlook documentation.

• Request inactivity threshold (mSec)
This value is given in milliseconds. It specifies the amount of time until a new 
retrieval of appointment data when you change entries in the DS View data 
view.

Exchange Server 2010

For Exchange Server 2010, the configuration is similar but not identical with the 
configuration of Exchange Server 2007. Via Exchange Web Services API (EWS), 
client applications communicate with the Exchange Server. The EWS provides 
access to most of the same data that is available by Microsoft Office Outlook.

The following settings are required for Presence Management in DS-Win:

• enable on Exchange Server:

– Client Access role

– Autodiscover Service

– Availability Service

• and configure the DS-Win client

Testing the Exchange Server 2010 settings:
Because Outlook Web Access (OWA) also needs these services, configure OWA 
and test it. If OWA is enabled and works, DS-Win should also work.
A31003-G6640-U100-5-7619, 06/2020
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2.2.3  AC-Win Settings

Choose the AC-Win tab under Application settings to access the AC-Win settings.

Record selection originators

• Attendant intercept
Caller – Destination
This parameter regulates which record is selected following a normal 
attendant intercept: caller or destination

• Attendant recall
Caller – Destination
This parameter regulates which record is selected for a recall.
 A31003-G6640-U100-5-7619, 06/2020
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AC-Win Server

• IP number
This parameter is stored in the DSWin_View_config.xml configuration file.

• Port number
The default setting for the port is 54700. This parameter is stored in the 
configuration file DSWin_View_config.xml.

• Part of AC-Win window title
The AC-Win title is stored in the DSWin_View_config.xml configuration file. 
The first characters show suffice (case sensitive)

Search parameters

• Grid name at int. call:
Grid1 should be set here for reasons of backward compatibility. The AC-Win 
query is performed in the first table.

• Grid name at ext. call
Grid1 should be set here for reasons of backward compatibility. The AC-Win 
query is performed in the first table.

• Search field at int. call
Database field name in the subscriber table (controls the choice of data 
record in the event of a query from AC-Win. TieInvertedNumber should 
remain set here for reasons of backward compatibility.

• Search field at ext. call
Database field name in the subscriber table (controls the choice of data 
record in the event of a query by AC-Win. InvertedNumber should remain set 
here for reasons of backward compatibility.

• Tabsheet at int. call
The default setting is 0. This parameter determines which tab should be 
selected in the event of a query from AC-Win. Possible values are 0 to 3.

• Tabsheet at ext. call
The default setting is 0. This parameter determines which tab should be 
selected in the event of a query from AC-Win. Possible values are 0 to 3.

• Company
Contains the field name of the subscriber table for the values returned to AC-
Win. The default setting is company.

• Sortname
Contains the field name of the subscriber table for the values returned to AC-
Win if "automatic name retrieval" is set in AC-Win.

Key pressing

• Data source
When a key is pressed in AC-Win, DS-Win searches for this data source.
A31003-G6640-U100-5-7619, 06/2020
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– Subscriber: Default setting if a PostGreSQL database is used.

– MS SQL Subs: Setting if an MS SQL database is used.

• Search field
When a key is pressed in AC-Win, DS-Win searches for this field in the data 
source.

• Search panel
When a key is pressed in AC-Win, the characters are displayed in the search 
panel in DS View.

• Dial properties
If you click this button, the following dialog is displayed with fields from the 
subscriber table:

You can determine in this table which button dials which station number. Note the 
call parameters in the GUI Designer for ActionType = PHONECALL in this regard. 
The CallNumber parameter 0 to 9 corresponds in this case to the table row.

The following values contain database field names, whereby it should be noted 
that input is case sensitive:

• Use internal flag

• Data source

• Internal code

• Domain

• Tie number

• Country code

• Area code

• Net code

• Extension
 A31003-G6640-U100-5-7619, 06/2020
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Settings
Confirm input in each dialogue window by clicking OK.

If an MS SQL database is used, the table has to be filled as follows:

• "Ctrl 0": MS SQL Subs

• "Ctrl 1": MS SQL Secr

• "Ctrl 2": MS SQL SubSubscriber

• "Ctrl 3": MS SQL Subs

NOTE:  The "Ctrl 0" value is assigned with the "CallNumber" property of the GUI 
Designer.
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DS-Win V4, DS View, User’s Guide 17

         



Data View

DS-WinBH_ch02.fm

Settings
2.2.4  BLF-Win Settings

Choose the BLF-Win tab under Application settings to access the BLF-Win 
settings.

• Active
This setting should only be enabled if BLF is installed on the same computer 
as DS-Win. 

• BLF window title
Part of BLF window title. Only the first pair of significant characters are 
important (case sensitive) for identifying the window.

• BLF-Win number field
Corresponds to the field name of the Station field in the subscriber table. 
Please use the default settings for reasons of backward compatibility.
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2.3  The Standard Screen

Workspace

Status bar

Menu barToolbar Title bar

Search fields

The window illustrated shows the configuration supplied with the software 
package. It may look different in your application if it has been adapted to the 
requirements of your company by the system administrator.

Please note that the size of the window should only be adjusted using the "GUI 
Designer" program. If you enlarge or reduce the size of the window while DS View 
is running, it may happen that components are not enlarged or reduced 
automatically at the same time and therefore may not be visible.

You can select the DS-Win functions in the standard screen using icons and 
menus. The icons in the toolbar enable you to structure the data view on the 
screen. The menu items that appear when you click on them are self-explanatory.

If you drag the cursor onto the fields in the menu bar or toolbar, the relevant 
functions will be displayed. When you do this for the first time it may be necessary 
to click on them to make the functions visible.
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File menu • The "File" menu is required for opening DS-Win applications that can be used 
alternatively.

• If you click on Open, the DS-WIN applications contained in the current directory 
are displayed. Double click on the application you require.

View menu • You can use the "View" menu to activate or deactivate the status bar and toolbar.

Options menu • The "Options" menu provides you with additional functions: 
It enables you to select a search procedure and various print options, to 
configure the application and set the language. You can make changes to data 
records by clicking on Edit.

Help menu • By clicking on Help, you can access the online help.

1 2 3 4 65

If you then

(1) Open a dialog file you look for your file and place it in the workspace.

(2) Select edit mode you switch modes (view or input mode).

(3) Activate a speed search you switch to a search using a character string.

(4) Activate a result search you switch to a search using defined terms.

(5) Set print mode to "List" you print the displayed data in list form (phone book).

(6) Set print mode to "Record" you print a single record.

The large screen area is your workspace which is terminated at the bottom by the 
status bar. The workspace can be configured individually and may therefore differ 
in appearance from one installation to another. The workspace is where you 
make your entries and results are displayed. Messages and information about 
completed program steps and the status in different modes are displayed in the 
status bar.

The system is controlled via the menu bar. 

When you click on the titles above, the following sub-menus are opened:

You can also call up some of these dialogs directly from the toolbar underneath:

From left to right:

The buttons in the workspace make it easier for you to use important DS-Win 
functions. The layout of the buttons depends on your individual settings and may 
differ from the layout depicted here.
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If you click then

Subscriber
Secretary
...

you call the selected subscriber via their phone number. You can dial additional phone 
numbers using other configured buttons (for example secretary, mobile telephone).
Note: 
If additional phone numbers are configured, you can dial them using the key combinations 
Ctrl-1... Ctrl-9. Refer also here to the "Dial parameters" dialog, which you can access via the 
"AC-Win" tab with the "Dial parameters" button. The CallNumber parameters for the 
"Action Type=PHONECALL" button, which are defined in the GUI Designer, also take effect 
here.

Phone book/
Record

you print either all displayed records (phone book) or only the record that is marked at the 
moment.

Result you start a result search.

Clear you delete all entries in the search fields.
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2.4  Searching for Data

You can choose between two search methods: 

• Result search 

• Speed search

You can set the search mode via:

• Options

• the toolbar

• function keys (F5 for speed search, F6 for result search)

F5 for speed search

F6 for result search

Click with the mouse to activate the search mode you want. This will then be 
active in the following search procedure.

2.4.1  Speed Search (F5) and Automatic Dialing

With the speed search, the characters in the search term are entered in 
successive order in only one field; the system immediately directs you to the 
record that best matches your entry.

The records are sorted according to the column in which you are searching. If you 
enter a search string in the search field of another column, data is sorted 
according to this column before the search task is initiated.

As soon as the correct entry is found, the connection can be set up by pressing 
the Station key (subscriber or secretary). You can reach alternative numbers via 
other buttons if configured, and using the key combinations "Ctrl-1 ...  Ctrl-9".
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2.4.2  Result Search (F6)

If you use the 
wildcard

the system replaces

? any individual character.
Example: With "MA?OR" all values are searched which start with "Ma", end with "or" and also 
contain additional letters in the middle, for example "Major", "Mayor", "Manor", etc.

[..., ...] only characters between brackets.
Example: With MA[N,J,Y]OR, only "MAYOR", "MAJOR" and "MANOR" are searched.

[...- ...] only characters between brackets.
Example: 0-9 means all characters.

Select this method to look for linked search criteria, e. g. according to name and 
department simultaneously. After entering the search criteria in the search fields, 
you can start the search process by clicking the "Search" button or by pressing 
F3.

The result you receive from this search will be the set of records corresponding 
to the criteria entered. 

You can search with or without a wildcard. With wildcards, you can either extend 
or restrict search criteria as required:

You should note that when using other databases, other wildcards may be 
required.

2.5  Pre-Selecting Areas

If your data is divided into various areas, you can use the combination box in the 
upper right margin to preselect records. To do this, open the list of available areas 
and mark the corresponding entry. Only records from this area are now displayed.
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2.6  Viewing Search Results

After completing a search, the result is displayed on the screen in edited form. 
You can change the display to show detailed data (see Section 2.6.1 on page 2-
24) and you can also print out the results (see Section 2.6.4 on page 2-29).

2.6.1  Displaying Detailed Data

You have the option of displaying detailed data both on the "Search for 
subscribers" tab and on the "Selected subscriber" tab.

2.6.1.1  »Search for subscribers« Tab 

Slider

Arrow keys

You can display detailed data in the result table. If the first column for a record 
displays the  icon, you can simply double-click on this icon to display 
additional data in sub-rows.
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The sub-rows can be selected using the CTRL+Arrow UP or CTRL+Arrow Down 
key combinations.

Show All

If you want to show all displayed records in this way, click on the "Show" button.

Hide Detailed Data

The detailed data of an individual record is hidden.

Hide All

If you want to hide the detailed data of all displayed records click on the "Hide" 
button.

Merging a Display

A display containing several records of the same type can often be very 
confusing, especially if the contents in the individual fields are similar. 

In order to structure a display of this kind click on the "Merge" button. The 
structured display is not shown. If you first displayed the detailed data, the 
detailed data is hidden automatically for the structured display. 
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Cells that are horizontally and vertically adjacent and that contain the same 
information will be displayed by DS-Win as a single large cell, which increases 
clarity considerably. 

There are several ways of moving about the table

• by clicking the arrow keys to scroll up and down in the list 

• by dragging the slide tab to scroll to the upper or lower section 

• by using the cursor keys to access other data records in the table – the 
current data record is darkened.
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2.6.1.2  »Selected subscriber« Tab

You can use the "Selected subscriber" tab to switch to form display for the record 
currently marked. This display is also required for editing individual records.

There are several ways of switching the current data record. You can use the 
following buttons to do this:

• First for the first record in the table

• Previous for the previous record

• Next for the next record

• Last for the last record in the table
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2.6.2  Altering Sort Settings

Step Action

1 Click on the title of the column according to which sorting is to be performed.
Result: The table is resorted accordingly.

You can easily modify sorting for your search result.

The value of the field on which sorting is based is imported to the search field. 
This simplifies searching in this column because the term which has already been 
found does not need to be entered again.

Examples:
A specific subscriber was searched for, however no connection was possible as 
the subscriber was unavailable. The caller asks to be connected with another 
subscriber in the same room. In this case, simply click on the column "Room" to 
immediately display all subscribers in the room where the originally requested call 
partner is located. You can now select a new subscriber.

Because a connection could not be set up with the first subscriber searched for, 
the caller asks you to connect him to the supervisor of the relevant department. If 
departmental names are classified hierarchically, the supervisor’s departmental 
name contains either one letter or one digit fewer. Click on the "Department" 
column and then press the backspace key to delete the last characters of the term 
contained in the search field. This branches you back to the higher hierarchy 
levels where the other station required can be found.

2.6.3  Deleting Search Criteria

Step Action

1 Press the key combination Ctrl + Del.
Result: The contents of the search fields are deleted.

If you have entered several search criteria for the result search, you do not need 
to delete each search field individually before a new search. Simply use the 
corresponding accelerator.
 A31003-G6640-U100-5-7619, 06/2020
28 DS-Win V4, DS View, User’s Guide

        



DS-WinBH_ch02.fm

Data View

Viewing Search Results
2.6.4  Printing Results

You have the option of printing

• a single record or

• the complete list of all records (phone book).

Step Input Action

1 Switch to the result search.

2 Text Enter the required search criteria in the search fields "Location", "Department" and 
"Name". You can also only use the first characters of a search term.

3 Press the "Result" button on the right side of the main window.

4 Switch to the print mode "List" and select a print form.

5 Press the button "Phone Book" on the right side of the main window.
The records are now printed in the required order.

To do this, activate either Print List or Print Form in the toolbar.

Depending on the switch setting you have selected, either the Phone Book or 
Record button will be displayed clearly for selection. 

All available print forms are displayed in the "Options" menu under "Print form". 
You can click to select a print form.

In the print mode "List" the records are printed in the same order as displayed in 
the output table. If you switch to the result search before printing, you can 
conveniently define record selection and sorting. Record selection is defined by 
specifying search criteria in the search panel. All fields completed in the search 
panel are used for sorting. The search field to the furthest left is the main sort 
criterion. All other completed search fields are included in sequence in the sort 
criterion. 

Example:
You would like to print a list sorted according to location, and within the location 
according to department, and then according to name.
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2.7  Editing Records

The Data view window allows you to edit individual records directly, providing you 
have the appropriate access authorization to the database. Switch to the 
Selected subscriber tab because it is only possible to edit data records in form 
fields and not in the list view.

You can switch from display mode to input mode as follows: 

• By choosing the Edit menu option in the Options menu or 

• By clicking the "Input mode" icon or

• Using the F2 key

• Other buttons appear on the right-hand side of the workspace.

• You have already selected a record. To edit the current record, you have to 
click in an editable field. The buttons on the right side are then activated. 

When the database is edited with another program, the modifications will be 
visible after the table page is reloaded in the list view. The table page can be 
reloaded by selecting an entry from the list and pressing the CTRL+R key 
combination.

2.7.1  Editing Records with the Control Buttons

When you click the ... button then

you save the changes in the current record.

you discard changes.

you remove the current record from the database.

you insert the new record in the database.

you create a new record.
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2.7.2  Editing Combination Boxes with the Keyboard

Using the key or key 
combination

you can

Alt + Down arrow display the possible values in a drop-down list.

UP, DOWN scroll line-by-line though the list.

PgUp, PgDn scroll page-by-page through the list.

Shift + Enter accept the selected value in the combination box.

Del delete the value in the combination box.

Text is not entered directly in combination boxes, rather it is selected from a list 
of possible values and then transferred to the field. These fields can be edited 
both with the mouse and the keyboard. If the cursor is located in a combination 
box (field content is selected), the following accelerators are available.

Requirement: The combination boxes were preconfigured in the GUI Designer.

2.8  Opening an Existing Database in DS View

When DS-Win is started, a database containing the last settings saved appears 
automatically. You can open a different database via the File > Open menu.
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3  E-Mail Client and Presence Management

3.1  E-Mail Client

3.1.1  Features

DS-Win V4 supports the following e-mail formats: 

SMTP Server
The e-mails are transferred to an available SMTP server in the network. This 
server is responsible for delivering the e-mails to the addressees.

SMTP Relay
The e-mails bypass the SMTP server and are sent directly to the address 
domain’s e-mail server. To find this domain’s mail server, there must be a DNS in 
the LAN and it must be possible to reach the destination computer in the e-mail 
address via this DNS.

MAPI
If an Outlook client is being operated on a DS-Win desktop, which supports the 
MAPI protocol, then both the interface of the Outlook client and the interface of 
the DS-Win e-mail client can be used. The e-mail address can be transferred 
automatically from the DS-Win database in this case also. 

Outlook OLE
An existing MS Outlook must be started (not Express) and is used via the OLE 
interface.

E-mail messages are only sent in this mode - none are received. When using the 
SMTP modes, it is also technically impossible to receive e-mails.

Automatic Transfer of e-mail Address to the e-mail Client.
A database field can be programmed freely so that the e-mail address is 
automatically transferred to the DS-Win e-mail client.

Standard texts for both the Subject Line and the Message
Standard texts for all languages released are supplied in the Message.doc file 
and can be customized. 
This Message.doc file and samples of standard texts can be found after 
installation in the DS-Win directory "ProgramData\Unify\DS-Win V4\SendMail\". 

Three different standard texts can be accessed in the e-mail client via buttons. 
The names of these buttons are freely programmable.

The message is displayed in RTF format (Rich Text Format) which supports the 
use of a range of fonts, styles and colors to make layout clearer.
The text can be edited directly in the e-mail client. The range of RTF formatting 
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options available here is limited (e.g. no Color selection). WordPad is available in 
the e-mail client menu and offers a better selection of RTF formatting options for 
editing messages. The actual text displayed in the e-mail client is then 
automatically transferred to WordPad. The changes made are immediately 
displayed in the e-mail client once you have saved and quit WordPad.

Adaptation of Customer-specific Dialogs for DS-Win Data View with the e-
mail Client
You can use the Designer to modify existing DS-Win data view custom dialogs for 
use with the e-mail client. The section entitled Configuration of the E-Mail Client 
contains instructions on this.
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3.2  Configuration of the E-Mail Client 

3.2.1  Prerequisites

The DS-Win e-mail client can be used by the attendant staff to send an e-mail 
informing absent/busy subscribers about a call. 

There is no need to reply to this e-mail and consequently the system is not 
designed to receive e-mails (to avoid involving another host (POP3)).

The client therefore only supports the SMTP protocol (not POP3) for sending e-
mails. 
The network therefore must feature an SMTP host or a DNS (Domain Name 
System) when using SMTP Relay. 

If you want to receive e-mails, an e-mail program that supports the MAPI protocol 
(e.g. MS Outlook) must be installed on the DS-Win workstation.

The DS-Win e-mail client can retrieve the e-mail address of the subscriber to be 
notified from the database. This is supported for SMTP/MAPI/OLE. 
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3.2.2  Customizing Customer-Specific Dialogs / 
Configuring a Button for E-Mail

For default installation, the supplied configuration files "<INST DIR 
>data\forms\designer_de.xml" or "<DSWIN INSTALLDIR 
dir>\data\forms\designer_en.xml" already provide preset e-mail configuration 
data.

The e-mail function must be manually configured if customer-specific 
modifications have already been performed in DS-Win. To do this, please refer to 
the instructions that describe how to program the button with the e-mail function 
in DS-Win and how the database field can be displayed with the e-mail address 
in DS-Win.

To enable the sending of an e-mail, a button must be programmed with the Send 
Mail function and a name (in this case: Send Mail) assigned.
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Precise configuration details can be found in the Designer manual in the Chapter 
"e-mail Client Dialog Configuration".

3.2.3  E-Mail Settings

Before you can send e-mails, a number of modifications must be performed on 
opening the "Email Settings" tab in the Application settings dialog for the first time.

Open the Application settings menu from the options and select the "Email 
Settings" tab.
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If a checkmark is set for Subject and Message under Defaults, then the current 
texts entered in these two fields in the eMail dialog are saved as standard Text1. 
Every time the Send Mail button is now pressed, these texts will be displayed 
under Subject or Message. 

7 WARNING

The changeover to the MAPI/Outlook e-mail User Interface is permanent but 
is configured in DSWin_view_config.xml. See Section 3.2.3.5, “MAPI/
Outlook E-mail User Interface”, on page 41.

The following dialog will appear after selecting a subscriber and pressing the 
Send Mail button:

Please note that the caller’s telephone number cannot be inserted correctly if the 
wildcard for the telephone number (+XX (XXX) XXXX) was deleted. In this case, 
1234 is added after "Caller Number:"!!!

Comment: The wildcard XX [XXX} XXXX itself can be defined by qualified 
personnel in the message files Message1.txt or Messag2.txt in the DS-Win 
directory "ProgramData\Unify\DS-Win V4\SendMail":
For example change to. +XX[XXX] - XXXXXX:
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The wildcard parameter can also be changed in the file 
"C:\ProgramData\Unify\Ds-Win V4\config\DSWin_View_config.xml". Should you 
change it, please make sure that the value in the configuration file is identical to 
the value in the "Message.txt" file.

Comment: The telephone number is not inserted if this entry contains fewer than 
two characters. The number of the incoming call is available as soon as "Send 
Mail" is pressed and replaces the wildcard.

The mail texts are saved in the files Message1-3.txt in the DS-Win directory 
C:\ProgramData\Unify\DS-Win V4\SendMAil. Three different standard texts 
can be selected for the message with the buttons Text 1-3. The standard text 
displayed can be temporarily deleted by pressing Delete to send an e-mail with a 
different text.

3.2.3.1  E-Mail Type

The e-mail transfer method can be defined with "Email type". 

3.2.3.2  Defaults

Specify whether the Subject line is to be used. 

To send an e-mail, the sender’s e-mail address must be entered in the Sender 
field (in this case the attendant console). This entry is used as the sender in the 
e-mail so that the e-mail recipient can see who sent the message. This entry must 
not be a real e-mail address, but Microsoft naming conventions must be 
observed.

An e-mail address can be entered in the BCC field (optional) to which a copy of 
every e-mail is to be sent by default. This must not be used and is only provided 
here for information purposes showing who the e-mail was sent to, when it was 
sent and what the contents were.
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3.2.3.3  SMTP Server

The name or the IP address of the SMTP host on the network is entered in the 
Hostname field (if necessary, consult your network/SMTP host administrator).

The default Port need not normally be modified. 

Whether or not the UserID has a significance depends on the configuration of the 
SMTP host. This field must not be left blank however. Although SMTP hosts 
frequently overlook this UserID, an entry must always be present. Please check 
with the SMTP host administrator to see if a random text (for example "default", 
"attendant") or a particular user login is necessary. The Passwort only has to be 
entered here if the SMTP server also expects a password for UserID. The 
Timeout parameter specifies how long the system waits for a DNS response 
when sending a message before aborting the send attempt.
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3.2.3.4  SMTP Relay

SMTP Relay mode can also be used here if the SMTP host is not known or if there 
is no special SMTP server available. In this case, the DNS (Domain Name 
Server) is used to determine the receiving mail server for every e-mail address, 
and the mail is sent directly to this server. (A task that is normally performed by 
an SMTP server.) For this to work, it must be possible to reach the 
destination computer specified in the e-mail address via this DNS. The IP 
address of the DNS can be determined in the DOS box with the command 
IPCONFIG /ALL. Whether or not this mode works within the network depends on 
the configuration of the DNS and the e-mail server. 

3.2.3.5  MAPI/Outlook E-mail User Interface

The MAPI setting facilitates the use of external e-mail programs that support the 
MAPI interface (for example Outlook). In this mode, the current mail settings of 
the external software are applied (User name, Server etc.).

3.2.3.6  Outlook/OLE

This setting can only be used if an Outlook client is installed on the DS-Win PC. 
Outlook is then addressed directly via the OLE interface. This may be faster than 
via the MAPI interface. A choice of user interface is also available here (see under 
MAPI).
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3.3  Presence Management for DS-Win V4

3.3.1  Description of DS-Win Presence Management

Public 
Network

AC-Win, DS-Win
and BLF-Win

or

This new function does not affect the traditional DS-Win attendant console 
functions or the interworking with external OpenScape applications (AC-Win, 
BLF). 

Presence Management for DS-Win can run with Microsoft Outlook 2003/2007, 
with Exchange Server 2003 as well as Lotus Domino R8 / Lotus Notes R8.

Figure 2 Overview of OpenScape Applications
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MS Outlook Client 
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Figure 3 DS-Win V4 Configuration Overview

3.3.2  Configuration Requirements

Microsoft Outlook 2007 must be installed on the same PC as DS-Win. 

First activate presence management and set the requisite parameters (see 
Section 2.2.2, “DS-Win Presence Settings”, on page 4).

3.3.2.1  Outlook

Since calendar data for MS Exchange Server (2003) is accessed with Outlook 
2007, a mailbox for Outlook should be configured on the mail server (MS 
Exchange). If the Exchange server is integrated in a network and synchronization 
between the individual servers is configured, then data retrieval is possible 
throughout the net. 
A31003-G6640-U100-5-7619, 06/2020
DS-Win V4, DS View, User’s Guide 43

         



E-Mail Client and Presence Management

DS-WinBH_ch03.fm

Presence Management for DS-Win V4
3.3.3  Description of the »Presence« Window

Figure 4 The "Presence" window 

The "Presence" window can be positioned between the data grid and the search 
panel, for example. However, this position can change at any time because, like 
other window elements, this window is created in runtime mode with the DS-Win 
Designer. 

The calendar entries show the presence of the selected user in chronological 
order (current record: red). As usual, records can be changed using the mouse, 
arrows or in the Search field, and the data retrieved after a short period of 
inactivity (see Section 2.2.2, “DS-Win Presence Settings”: 
ChangeSelectionmSec) from Outlook or Lotus.
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These records are used as label text for the 12 fields in the "Presence" window 
and displayed in 3 rows and 4 columns. They can have the following values and 
meanings:

Icon Date Time Status

No longer actual 3 May All Day Tentative

 Actual Today 8.30-9.00 Busy 

Not yet actual 3 May - 6 May Out of office

In Lotus Notes, only the "Busy" status is available.

The entries are the three most current entries of the selected user . They normally 
refer to the present or the future. However, one (or more) entries can in worst 
case be from the past as well, but only today, if there is no other suitable data for 
the present or the future.

The display of a past event from today can be important, for example, if a meeting 
doesn’t end on time.

In Outlook, it is possible to make overlapping calendar entries. In such cases, DS-
Win shows only one entry; the following priorities apply:

• High:Out of office

• Average:Busy

• Low:Tentative

Identification is performed in Outlook or Lotus Notes; accents can be omitted. As 
in Outlook, it is only necessary to enter the key portion of a name.

The time is not shown if the status is "Out of office" and applies all day. Instead, 
only the start time and end time are shown ("All day" means that the start time 
corresponds to the StartWorkHour constant and the end time corresponds to the 
EndWorkHour constant. See Section 2.2.2, “DS-Win Presence Settings”). This 
process is known as "combining date elements".

For the current date, the date is not shown but rather the text constant "Today".

The text "All day" appears in the Time column if the relevant activity takes all day. 
The start time corresponds to the StartWorkHour constant, and end time 
corresponds to the EndWorkHour constant. See Section 2.2.2, “DS-Win 
Presence Settings”).

Output is to an accuracy of 30 minutes. The entry 8:32-8:45 is shown for example 
as 8:30-9:00.

If the e-mail address field is empty, the FirstName and LastName columns from 
the subscriber table for the selected record identify the e-mail account. If the e-
mail address field is filled out, however, these entries will be sent instead of the 
name columns because this information is more unique.
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• German (designer_de.xml) • Dutch (designer_nl.xml)

• English (designer_en.xml) • Danish (designer_da.xml)

• French (designer_fr.xml) • Hungarian (designer_hu.xml)

• Italian (designer_it.xml • Czech (designer_cs.xml)

This "Presence" window appears in the following distributed dialog files: 

You can use the Designer to modify existing DS-Win data view custom dialogs for 
use with "Presence Management". 

For information about this, see the "E-mail Client Dialog Configuration" chapter in 
the Designer manual.

If you no longer need the "Presence" window and need the space for other 
purposes, proceed as follows:

1. Clear down the database connection.

2. Remove the components described above.

3.3.4  Extreme Situations

The following windows containing security information appear when installing 
security patches for Outlook: 

This warning is only issued if the security setting is not suppressed. Refer to 
Abschnitt 3.3.6 for information on how to suppress this setting.

The user should select the maximum time (10 minutes) to minimize disruptions to 
standard operation. This warning can be deactivated for individual users or user 
groups in the Outlook server configuration. For further information please ask the 
specialist staff. Further information on this subject can be found in the Service 
Manual.

Special handling rules determine how to proceed in exceptional situations, for 
example if the Exchange Server is not available. In this case, the following 
message appears: 
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Follow the instructions. If this does not solve the problem, please contact the 
specialist staff.

3.3.5  Performance

It takes less than a second to retrieve account data from a local server. 

MAPI server data can only be refreshed by logging off and on again. This takes 
on average 2-3 seconds every 2 minutes (default value for SessionRefreshMin). 
This process runs in the background of a separate thread. The period of inactivity 
(default value ChangeSelectionmSec 500 ms.) is preset to prevent excessively 
quick selection. 

A delay time (approx. 5-10 minutes in Outlook 2007 or exit and logoff Outlook) is 
set for synchronization between the Outlook Calendar update and the updated 
answer from the Exchange Server. The data is thus not immediately updated 
when the user creates a new calendar appointment entry. Unfortunately, we have 
no control over this side effect. 

1. In Outlook, select Tools -> Options -> Calendar Options -> Free/Busy 
Options. 

2. Set the value for "Update free/busy information on the server every x 
minutes" to the minimum value of 1 minute.
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3.3.6  Creating Custom Security Settings

Security settings for Outlook users can be individually adapted in the Outlook 
Security Form. This form is available via Outlook Security Settings (Public 
Folders). Fill out this form and send it off. You can do this in two ways: you can 
create a custom security setting that applies to a specific user group or you can 
create a default security setting that applies to all users who are not included in a 
custom security setting. When you choose a custom security setting, you do not 
need to specify any users, you simply set the "Security Group Name" to "Default 
Security Settings.oft". You will find this file under "C:\Program Files\Unify\DS-Win 
V4\Outlook\OutlookSec". Please refer to the file "ReadmeOutlookSecurity.txt" in 
the same directory to establish how and under which conditions this file can be 
opened.
 A31003-G6640-U100-5-7619, 06/2020
48 DS-Win V4, DS View, User’s Guide

        



DS-WinBH_ch03.fm

E-Mail Client and Presence Management

Presence Management for DS-Win V4
Tab 1 in the Outlook Security Form: Outlook Security Settings

Tab 2 in the Outlook Security Form: Programmatic Settings

Example: You can create a Power Users item that contains a list of members and 
the custom settings for this group. User names are stored in the Members box of 
the form and settings are stored in a variety of user-defined Outlook fields. 
Security features that you can configure include the following: attachment 
security, the Outlook Object Model Guard, the Simple MAPI guard, and the file 
extensions contained in the Level 1 or Level 2 lists for attachment security. 
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The following two windows show the minimum settings required to run DS-Win 
V4.
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